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[bookmark: _Toc181625738]Section 1 – Introduction/Tools Overview
[bookmark: _Toc181625739]Primary audience
This guide was created primarily to help Bloomberg Tax Content Analysts and Authors use the tools necessary for publishing content on the Bloomberg Research platform. It is intended for those using the Oxygen web author version. However, this guide should prove useful for anyone using these tools. 

[bookmark: _Toc181625740][image: A diagram of a system
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[bookmark: _Toc181625741]What is BWIP?
BWIP is a web-based management application that allows uses to check files out and into BDMS, edit and release updated and new documents to the customer-accessible Bloomberg Research Products.
[bookmark: _Toc181625742]What is Oxygen? 
Oxygen is an XML editor used to create and edit Bloomberg INDG research content that is managed in the BWIP publishing application.
[bookmark: _Toc181625743]What is BDMS?
BDMS (Bloomberg Document Management System) is Bloomberg’s central database that stores data and content that is used throughout the organization, such as what is published on the Bloomberg Research platform. 
[bookmark: _Toc181625744]What is Anthology?
Anthology is a content management system for configuring features and pages on the Bloomberg Law and Bloomberg Tax web platform. 
[bookmark: _Toc181625745]What is Autocat?
AI software that assigns taxonomy topics to published content. 
[bookmark: _Toc181625746]What is Bwrite?
The content management system that Bloomberg News uses to create, edit, and publish content. 
[bookmark: _Toc181625747]What is Orca?
The central image management system (repository) used across the entire organization that allows users to add an image to their content by using an Image (Orca) ID. See the Adding an image section below for more information. https://orca.dindg.com 
[bookmark: _Toc181625748]What is Public Docs? 
A web application and database used to upload supporting documents and assign unique public URLs that can be referenced in content published on INDG platforms and publications. https://public-docs.bindg.com/





[bookmark: _Toc181625749]Section 2 – BWIP
[image: Vlog with solid fill]For a video overview of BWIP, click here. 
[bookmark: _Ref179898142][bookmark: _Toc181625750]Login & Permissions
A. Use Bloomberg Okta login to sign-in to https://bwip.bindg.com/wip 
B. If you’re not able to access via the link above, log-in to https://bna.okta.com/ and select the BWIP app
[image: ]
[bookmark: _Toc181625751]Dashboard overview (WIP – Work In Progress)
A. The Left Rail includes the various BWIP views available (always defaults to WIP.
Note: The left rail can be expanded or collapsed using the arrows (<< / >>) at the bottom. 
[image: ]


i. WIP: main section within BWIP where files are displayed. Use this tab to select a file to edit. 
ii. TOC (Table Of Contents)/Browse: use this tab to find files by entire collections (service)
1. Select a service code from the ‘Service’ dropdown menu and then select the ‘Browse BDMS’ button (BDMS – Bloomberg Document Management System)
Note: This page only works for those services that have a table of contents. Otherwise use the BDMS Search option. 
iii. BDMS Search: a way to search for text or a specific file or collection directly from the central BDMS database, including expired (removed) content. 
iv. Releases: this tab provides history and status of files that have been released (published) or are scheduled to be released from the WIP. Files are listed by those released most recently. Note: Users can search for a specific file using the filters at the top of this page. 

B. [image: ]The Right rail shows specific information about the file that has been selected
[image: ]This is collapsed by default. Click the blue (<<) icon at the bottom right of the screen to expand.
i. The right rail incudes information about the document history (i.e. last edits, checkouts, and auto-saves), displays the BDMS ID, and footnote information. To restore a previous version of the file, view the steps in the Check Out History and Redlines | Restore a Version in WIP section of this document. 
Note: The BDMS ID is needed when submitting a Service Desk Jira ticket for help with errors or an issue with a document. 










C. The Top Rail includes action buttons and filtering/sorting options to control what is displayed below it. 
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1. Release
2. Create PDF
3. Create TOC
4. Move to Queue
5. Renumber Document Footnotes
6. Upload Files
7. More Menu 
A. Remove from Product
B. Send All to Autocat
8. Filter by Status
9. Sort options
10. Filter by Service
11. Filter by Queue
12. Refresh WIP
13. Search by Class Code
14. Search by Unit Code
15. Search by Publication Number
16. Search by BDMS ID

[bookmark: _Toc181625752]Services
Services are a collection of documents organized by the focus area of the content (i.e. foreign income) and the document type (i.e. portfolios). The service code is the unique ID to find the collection in BWIP (i.e. fip-por). 
[image: ]

[bookmark: _Toc181625753]File check-out
Locate and Check Out a Document with TOC/Browse

[image: A screenshot of a computer]












Note: To start over at any time, select Clear all values.

1. Click TOC/Browse on the left navigation panel. 
2. Click the dropdown arrow (v) beside Service to select the appropriate service. 
3. Click Browse BDMS.  All documents for the selected service are displayed. 
4. Click the plus (+) beside a document to open its table of contents.
5. Click the plus (+) beside subsequent levels to reach the document needed for check out. 
6. Click Checkout beside the required document. The button turns light gray when the document is successfully checked out. Note: If Checkout is already a light gray, the document has already been checked out.  Hover over the Checkout button to see who has the document checked out.
6.1. [image: A screenshot of a computer

Description automatically generated]To check out all sub-sections within a section within at once, select the Group Actions menu > Checkout All







Locate and Check Out a Document with BDMS Search 
Note: To start over at any time, select Clear all values.
[image: A screenshot of a computer
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1. Click BDMS Search on the navigation panel.
2. Click the dropdown arrow (v) beside Service to select the appropriate service. 
3. (Optional) Enter keyword(s) in the Text field, a BDMS ID in the ID field, or unit.start tag information into the Class Code or Unit Code fields.
4. Click Search BDMS. 
Notes: 
1) If you select Search BDMS when there is no data in the Text or ID field, all documents for that service are displayed.  
2) Documents are displayed in the XML file name format, but the service and file information appear beneath the file name.
5. Click Checkout beside the required document. The button turns light gray when the document is successfully checked out.  Note: If Checkout is already a light gray, file has already been checked out.  Hover over the Checkout button to see who has the document checked out.

[bookmark: _Toc181625754]Locate and Edit a Checked-Out Document in WIP
After checking out a document, locate it on the WIP page to edit it.
Note: To refresh only the WIP page, select the refresh icon beside the service filter instead of the browser refresh icon (or F5) which will refresh all the pages.
[image: A screenshot of a computer
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1. Select the Edit button next to the file you want to edit. The file will open in Oxygen. 
[image: A close up of a sign
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To edit a specific section of a document, select the Actions dropdown next to the file name. 
1. Select Edit Sections 
[image: A screenshot of a computer]
 
Note: Documents over 1Mb are too large to open entirely in Oxygen and need to be opened by individual sections. 

[bookmark: _Toc181625755]Updating a file status in BWIP
Documents checked out on the WIP page are labeled with statuses, which are displayed in the far-right column.  To filter the documents by a status, select the drop-down arrow (v) beside the Status field and make a selection.
Generally, a document’s status is assigned when a BWIP tool is run. A few of the statuses that are set automatically are: 
· Edit when a document is checked out of BDMS. 
· Pending Release when a user has chosen the Release file tool to post updates to BDMS. If a future date is entered, the document’s status will change to Pending Release until the update has been recorded in BDMS.
· Deleted when a new (unpublished) document is deleted from BWIP. 
· Abandoned when a user selects the Unreserve in BDMS – Abandon Edits tool.
Two optional statuses are Ready for Approval and Ready to Release. 
To change the status of a document:
1. Click on a document name to select it.  Note: A 1 appears to the left of the document name.
2. Click Actions to the left of the document name.
3. On the drop-down menu, make one of the following selections:
4. Mark For Edit changes the status back to Edit.
5. Mark For Approval changes the status to Ready for Approval.
6. Mark For Release changes the status to Ready for Release.
[image: A screenshot of a computer
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[bookmark: _Toc181625756]Unlocking Files in BWIP
1. If the Edit button is greyed-out (unclickable), BWIP believes the file is currently being edited.  A lock icon also appears beside the document name and the user ID of the one editing the file is found under the status. Search the user ID in Microsoft Teams to find and contact the individual who has the file locked. 
[image: ]
[image: ]If another user is editing the document, contact that person to discuss storing the file so you can edit it.  If BWIP shows that you are editing the document, and you are not, you can remove the edit lock with the following steps:
 
1. Verify you do not have the document open in a hidden tab or window.
2. Click Actions to the left of the document name.
3. Select Remove Edit Lock.


[bookmark: _Toc181625757]Queues
Allow for organizing documents that are in progress to associate them to a specific project. This allows individuals and teams to organize the documents they’re working on. Queues are accessed via a filter at the top of the WIP section. 
To select a queue: 
1. Select the WIP tab from the left rail
2. At the top of the screen, expand the Queues filter dropdown by selecting the down arrow (v) (by default, No Queues is displayed)
3. Type the name of the queue that you want or scroll to it and select it. The list of documents shown on the page will refresh. 
[image: A screenshot of a computer
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To add to a queue once a file has been checked-out and is in the WIP:
1. Find the document you want to add. 
2. Click the Actions dropdown.
3. Select Move File to Bwip Queue to move that file to a queue OR select Sendcopy to Bwip Queue to create a copy and send the copy to a queue. Note: If creating a copy, the file name will be changed to “Copy of: …” when added to a queue.
[image: ]
4. A popup dialog will appear, select the desired queue from the dropdown.
5. Select OK.
6. Refresh BWIP screen. Select the desired queue. 
[image: ]

To create a new queue, submit a ServiceDesk Jira ticket. 

[bookmark: _Toc181625758]Creating a new document in BWIP
A new document can only be created by finding and copying an existing document in the WIP, Queue or from the BDMS TOC and Search Views.
Copy:
1. Go to the TOC View or the BDMS Search view and locate a document similar to the one that needs to be created.
2. Select Actions > Sendcopy to Bwip Queue.
3. Provide a queue name in the dialog box.
The new file copy will be added the WIP or Queue and the document name will have “Copy of” prepended.
[image: A screenshot of a computer
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Clone:
1. Select the file that needs to be copied from the WIP or Queue view.
2. Select Actions > Clone.
3. The new file copy will be added the WIP or Queue and the document name will have “Copy of” prepended.
[image: A screenshot of a computer
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[bookmark: _Toc181625759]Re-numbering footnotes
This can be done directly in BWIP or in Oxygen. For large files, this must be completed in BWIP. 
1) From the WIP, select the desired file and select Actions.
2) Select Renumber Footnotes. A prompt will display on the screen with the following options: 
· Starting Number field – the starting number of the first footnote in the document 
· Renumber in Tables?  - option to renumber table footnotes if desired
· Renumber non-numeric footnotes? – option to renumber non-numeric (A, B, C, etc) footnotes in the document (if this is not selected, only numeric footnotes will be renumbered i.e. 1, 2, 3)
[image: ]
[image: ]
 
[bookmark: _Toc181625760]Publishing (Releasing)
Finished documents are released to BDMS, which then loads them to the BLAW and BTAX websites.
[image: Vlog with solid fill] For a video on the BWIP release process, select here.
Once edits to a document have been completed and approved:
1. Navigate to the WIP page.
2. Click on the document to be released. The number "1" appears next to the selected document. Note: To select more than one document to be released at the same time, hold down the Ctrl key and select to select additional documents or hold down the Shift key to select contiguous documents. A number appears next to each selected document.
3. Click the Release file(s) icon on the top icon bar.
[image: ]
4. The list of files to be released appears in the pop-up. Select when the files should be released:
a. To release now:
i. Click the radio button beside Now.
ii. Click Release Now at the bottom. Note: Multiple documents that are released Now will create individual Release Groups.  This prevents one failure from stopping other documents from releasing.
b. To schedule the release for later: 
i. Click the radio button beside Later. 
ii. Select the required date and time. 
iii. [image: ](Optional) Give the release group a Release Name.
iv. Click the Release on date at time button at the bottom.

c. To add the document to an existing Release Group:
i. Click the radio button beside Later.
ii. Click the dropdown arrow beside Add to pending release batch.
iii. Select the existing Release Group to which this document should be added.  Note:  Information on that Release Group, such as its date and time and other documents in the group, displays at the top of the popup.
iv. Click the Release on date at time button at the bottom.
v. The documents are released as scheduled.  
[image: A screenshot of a computer
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Note: On the WIP page, the status of documents scheduled to be released later is changed to pending release.
[bookmark: _Toc181625761]Exporting a file from BWIP
In BWIP, select the document from the WIP section. 
Note: You can select and convert/email more than one document at a time.  Hold the Ctrl key and click to select individual files.  Hold the Shift key and click to select contiguous files.
1. Click the Actions icon for that document. If multiple files are selected, select the Action icon for any of them. 
2. Locate the Export as… option
3. Select the desired format (i.e. PDF, Word) from the dropdown  
4. Click Export as…
The file will be downloaded via your browser and can be accessed through your browser’s downloads. 
[image: A screenshot of a computer]

[bookmark: _Ref179373487][bookmark: _Toc181625762]Check Out History and Redlines | Restore a Version in WIP
The details pane in WIP shows the history of a file since it was checked out.  View what edits occurred in each version and the cumulative edits since the file was checked out.  Select an earlier version to restore.
Open the Details View to See the History
1. On the WIP page, select a file.
2. Click the expand arrows (<<) on the bottom right to open the Details View, which shows information about this file.
3. The History shows what events have occurred to this file since checkout.
[image: A screenshot of a computer
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View Redline Changes or Restore a File
1. On the Details View, select edit beside an event under History.
 [image: A screenshot of a computer
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2. Select Diff to Previous to view changes made during this editing session.
[image: A screenshot of a computer]
3. Select Cumulative Diffs to view all the changes made since this file was checked out.
[image: ]
4. To make an earlier set of edits the current version, select the dropdown arrow (v) and select Restore to make it the current version. 
[image: ]




[bookmark: _Toc181625763]Section 3 – Oxygen
Oxygen XML Web Author is a web-based application for users to create, edit, or review content from anywhere, the only requirements being a modern browser and an internet connection. The web author version is sufficient for the majority of Oxygen users. 
Oxygen XML Desktop Author is XML editing software that can only be accessed from desktop operating systems and cannot be accessed via a web browser. It offers more robust and advanced XML editing features and tools. It is only available to a limited number of users.
This guide focuses on the web author version. 
Extensible Markup Language (XML) defines an international standard for storing structured content in text files using a defined coding or tagging system created by organizations to enforce content requirements.  Providing rules for applying structure and metadata to content improves reuse and content management and end product creation.


[bookmark: _Toc181625764]Login
Oxygen can only be accessed via BWIP. A file must first be checked-out in BWIP and then can be opened in Oxygen from the WIP. To log-in to BWIP, see the BWIP Login & Permissions section of this document. 

[bookmark: _Toc181625765]Navigation / menu overview
The top menu in Oxygen provides basic functionality for the file, the name of the file, and the user ID. 
[image: ]
1) Save
2) Undo
3) Re-do
4) Search the document
5) Spell check
6) More menu (advanced functions)
The mid-menu in Oxygen provides editing functionality. 
[image: ]
1) Change tracking
2) Accept changes
3) Reject changes
4) Add comment
5) Edit comment
6) Remove comment
7) Review previous change or comment 
8) Review next change or comment
9) Reviewing view options
10)  Oxygen help
11) Custom editing tools
Left Pane
Expand to view the document outline to help navigate to a particular section. It defaults to Contents outline view, a sequential ordering of section titles. Change the view to Structure to see a more detailed tag structure of the document. 
[image: A screenshot of a computer
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Right Pane
Expand to view review options, comments, and validation tool. 
[image: ]
Editing (main) Pane
This is where the document content is displayed (main section of the screen) and where edits are made. 
Breadcrumb
Allows you to change the tagging display within the editing pane. It also shows the hierarchical xml structure of the document based on the context of your cursor. 
[image: ]

[bookmark: _Toc181625766]Editing 
Select the text that you want to edit or place your cursor where you want to add new text. Use the tools in the mid-menu to format the text as desired. 
[image: ]

[bookmark: _Toc181625767]Tagging
Click the [image: ] icon at the bottom-left of the screen to change the tags that are displayed in the editing pane. Select the Full Tags with Attributes view to edit tags. 
[image: A screenshot of a computer
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Typical Oxygen document tag structure
Every document has the following tagging structure:
	Tags
	Description

	<pdm.module>
	Start document tag

	<info.unit>
	Document  wrapper

	<unit.start> or <portfolio.unit.start> or <book.unit.start>
	Unique collection and document metadata

	<analysis.98> or <sample.98> etc.
	Type of document

	<related.to>
	Document or section facet metadata

	<name>
	Document name

	<content.group>, <para>, <list.item>, <table>, <image>, etc.
	Document data contents


 
Most used tags
<content.group> - This tag has a nested structure, meaning each tag can contain a series of recursive <content.group> and may be used to create internal structure for document types such as <analysis.98> and generate document tables of contents on products.
To add a <content.group>:
1. Place cursor in a valid location
2. Press the Enter key and select <content.group> from the dropdown menu
3. All typical tags used to create a valid <content.group> will be inserted
4. Note that the <bna.id> tag should be modified or removed as needed to comply with the numbering formation of the document being updated
 
<para> : The main text of most documents are contained in Paragraph tags. The Para tag allows many other inline tags that may be used to format or further identify types of text such as citations, footnotes and list items.
 
<list.item> : Tags each item in a list inside of a <para> tag. It is usually preceded by an character like a bullet or an enumerator.
To add a <list.item>:
1. Place cursor inside <para> tag where the list is needed.
2. Either go to the mid-menu and select Insert > Insert List Item (tool includes a bullet) or copy and paste a <list> item from another location or Oxygen document.
3. Modify the list enumerator.
4. Add the text of the list item.

Inserting tags
1. Place your cursor where you need to insert a tag. 
2. Click Enter on your keyboard. A list of valid tags will display relevant to that section.
3. Select the tag you want to insert. 
[image: ]
Modifying tags
1. Select the tag you want to modify within the editing pane. 
2. Right click. A list of options will display. 
3. Select the function you want to do. The two most common functions are: 
a. Rename Element – select what you want to rename and enter the new tag name.
b. Delete Element Tag – deletes the tag but retains the tag contents. 
[image: ]
Removing tags and data
1. Select the tag you want to remove. The related data will also be highlighted. 
2. Select Delete or press ‘Control + X’ on your keyboard
[image: ]




[bookmark: _Toc181625768]Attributes
Attributes provide further information for individual tags within a document. 
Inserting attributes
1. Select the tag you want to modify within the editing pane. 
2. Expand the right pane if it is collapsed. 
3. Select Add Attribute.
4. Select the attribute you want to add in the Attribute field.
5. Enter the value of the attribute in the Value field. 
6. Click Add. The new attribute will be displayed in the main pane. 
[image: A screenshot of a computer
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[image: A screenshot of a computer

Description automatically generated]Modifying attributes 
1. In the main editing pane, select the tag you want to modify. 
2. In the right pane, the current attribute will be displayed. 
3. Edit the attribute in the field to the desired value.
4. Click Accept


[bookmark: _Toc181625769]Footnotes
To add a footnote, place your cursor immediate after the last word of text, with no space between. 
1. Press Enter on your keyboard and search for “footnote”. 
2. Click footnote in the popup.
[image: A screenshot of a computer
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3. Modify the tagging within the footnote, starting with “superior”. This is the footnote marker (number) that displays with the text in the document. Note: Before the document is released, the Renumbering Footnotes tool can be run to ensure all footnotes are numbered sequentially. 
4. Place your cursor in between the two ‘para’ tags for the new footnote and type the desired footnote text. If footnote has multiple paragraphs, you can add additional para tags to the footnote text tag. 
[image: ]

[bookmark: _Toc181625770]Copying/moving
It’s important to be mindful of the selected tags and data when copying content and moving it to a different section within the document or to a different document. 
1. To move an entire tag and its content, select the desired tag, cut, then paste to the desired location within the document or a new document. 
2. An error will appear if a copied tag is not valid at the new/intended location. To address, modify the tags associated with the text that you are trying to move. 

[bookmark: _Toc181625771]Inserting special characters/symbols 
Special characters and symbols can be added to documents in Oxygen in two ways. 
1. Insert a special character/symbol via the mid-menu toolbar in Oxygen by selecting the special character icon in the mid-menu.
[image: A screenshot of a computer
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2. Using keyboard shortcuts.
a. An up-to-date list of keyboard shortcuts can be found in Confluence here
[bookmark: _Ref181176010][bookmark: _Ref181176015][bookmark: _Toc181625772]Adding an image
1. Place your cursor where you want to add an image in the document.
2. From the mid-menu, select Insert and select Insert image.
3. Enter the Orca (Image) ID for the image you want to add. To find an Orca ID, visit Orca to search the image repository. 
[image: A screenshot of a computer
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4. Place cursor in the link text tag within the main editing pane and provide a description of the image. 
[image: A group of white rectangular signs with black text
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5. Click on the image and go to the right rail. It should display the Attributes tab. In the cd.display field, add inline or external if not already specified. (Inline – displays in the document, External – links to the document on the final product)
[image: A screenshot of a computer
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[bookmark: _Toc181625773]Tables
To create a simple table:
1. Place cursor where the table is needed.
2. From the mid-menu, select Tables > Insert Tables.
3. Enter in the table display information (number of rows and columns) in the Insert Tables field
4. Press Enter on your keyboard.
5. Place cursor in between the table cell tag either text or p and add the table data.
Note: the first row is the column header and highlighted in blue.

To add or delete rows or columns to a table:
1. Place cursor where row or column needs to be added or deleted.
2. From mid-menu select Tables and then select the desired Insert or Remove action for the row or column.

[bookmark: _Toc181625774]Folding Actions
Working in a large document can be cumbersome. Oxygen offers editors the ability to collapse (fold) their data in a variety of ways using the Folding submenu on the right menu.
Larger documents initially display in Oxygen in a collapsed view. 

Collapse all Folded tags:
1. Place cursor in document.
2. Right-click and select Folding > Collapse All from the menu.
3. All structural tag and data will be folded in the edit window.
 
Expand all Folded tags:
1. Place cursor where needed.
2. Right-click and select Folding > Expand All from the menu.
3. Folded tags and data will be unfolded and folded in the edit window.
Note: There may be performance problems when the Expand All tool is used on larger documents.

[image: A screenshot of a computer
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Other Folding actions such as Toggle, Expand, and Collapse other internal tags and data can be performed from the right-click Folding menu.

[bookmark: _Toc181625775]Editing Portfolios 
Portfolio services provide in-depth analysis of specific issues. Each Portfolio in a service has a unique Portfolio number. There are three common parts of an individual Portfolio:
1. Portfolio Description: This section includes Portfolio introductory documents such as the Portfolio Title and Portfolio Author Information that are rarely updated. The Portfolio Table of Contents are updated by the portfolio production group.
2. Detailed Analysis: The documents in this section contain the long form analysis chapters and are usually updated by Content Oxygen users. New chapters are added by the portfolio production group when requested.
 The documents themselves and the footnotes across are enumerated sequentially. 
Note: when updating a number of documents within the same section that the footnote renumbering tool may need to be used. It is important to note the beginning and ending footnote number of each Detailed Analysis document that was updated.
3. Working Papers (aka Worksheets): Working Papers are a wide variety of documents that may be excerpts of relevant primary source documents or other supporting materials for the information in the Detailed Analysis documents. New Working Paper documents are added by the portfolio production group when requested.
Most Content Oxygen users will only be involved in modifying existing Detailed Analysis documents or may make minor content updates to Working Paper documents

[bookmark: _Toc181625776]Editing Navigators and Charts
Navigators and Charts are types of Reference collections that feed Chart Builder tools on the web platform products. The documents in these Reference service collections often have a complex and highly nested outline structure to meet the Chart Builder tool requirements. The nested structure within each document uses complex Content Group tagging that must occur in a specific order. They also have special tagging for paragraphs to indicate if the text in the paragraph should be included or excluded in the Chart or if it should only appear in the chart. The rules for tagging, updating and maintaining the documents in each Navigator or Chart collection may differ based on the final product requirements.

[bookmark: _Toc181625777]Editing Reference
A Reference service is a group of documents in a collection that present analysis, primary source documents, practical guidance, and examples in an easy-to-use format to customers. The collections on product are usually organized by topics, allowing users to find relevant information quickly. The collections in BWIP are organized by service codes which may or may not align with the presentation on the product. Some Reference collections are organized in a specific way so the data can be used for Chart Builder tools on product.
The documents in Reference service collections are organized as follows:
Class: Documents in a Reference collection may be grouped under one or more Classes. It is the highest level of organization within a Reference service collection and typically corresponds to a year, jurisdiction, or topical heading. This information is required for BWIP and product organization. A reference collection may have multiple Class levels but must have at least one.
Subclass: Document units may be further organized with one or more Subclasses within each Class. This is not required.
Unit: This is the individual document level. Each Unit should have a name and a unique id that may be used to sort or display in the BWIP publishing system. It may also be used to sort documents with collections on products. Each Unit document may be opened in Oxygen and edited and released to be published from BWIP. There are many kinds of Units that may be used to produce a reference collection, such as: Analysis.98, Sample.98, Annotated.Source, Compilation.95.

[bookmark: _Toc181625778]Editing Books
The Book services (referred to as Treatises on product) in BWIP are the electronic files that make up traditional print book volumes and are typically written by outside authors. In the BWIP TOC view, the files in the Books services are organized in common book structures with three sections: Front Matter, Book Body and Appendices. The updating and maintenance tasks for Book files in BWIP are only completed by the production groups. When it is time for a Book to be updated all documents in the entire book collection are replaced and published.

[bookmark: _Toc181625779]Reviewing Tools
[image: A red and blue square with black text

Description automatically generated]After all edits have been completed, use these review tools prior to saving and closing the document in Oxygen. 
Expand the right-rail. 
1. Validation: checks the tagging and displays any errors. 
a. For information on troubleshooting common errors, see section Section 4 – Troubleshooting (Errors)
2. Bpub validation: checks to ensure the document meets the Bloomberg publishing requirements such as duplicate EIN’s, empty tags that need to be deleted, and missing name titles. 
a. For information on troubleshooting common errors, see section Section 4 – Troubleshooting (Errors)
3. Footnote viewer:  checks the footnote numbering and text throughout the document to ensure all are in sequence. 


[bookmark: _Toc181625780]Save Gets (customizable shortcuts) 
Save/Get keys are personal macros, or saved selections, that editors program for their own convenience to insert text and/or tags. An editor may save up to 9 different keys with text and/or tags that they want to re-use. A primary use for a save-get key is to save a lengthy name of legislation that is used in multiple files to avoid having to type it over again. 
Program a Save/Get Key Combination
1. In the Oxygen file, enter the tags and/or type the text that you want to save for future use.
2. Highlight the text and/or tags you want to save. 
a. If you are using tags that are already in the file, remove the id attribute value before creating the Save/Get. You can use Undo to put the EIN back when you are done. Or, create a brand-new, empty example and highlight it instead. 
3. Press [Ctrl + Shift + a number from 1-5] that is not already in use.
a. If you have already saved text or tags to that particular key combination, a box will appear asking if you want to replace it. 
b. If that particular key combination is empty, however, the highlight just disappears from the text/tag, and the selection is saved.
[image: A screenshot of a computer

Description automatically generated]
Use a Save/Get Key Combination
To use the save/get and recall the saved text or tags, place the cursor where you want to insert the saved data (such as on the command line or in the document), and press [Ctrl + the number].

Display a List of Your Save/Get Keys
To display a list of all your saved macros, choose Tools > Show Save Gets from the Oxygen menu bar.

[image: ]

[bookmark: _Toc181625781]Autocite
Autocite is a program that inserts citation markup for the creation of hyperlinks on INDG research products. It searches documents for specified text strings and automatically surrounds matches with the appropriate citation XML tags and attribute values.
To run Autocite: 
1. Manually save the document.
2. From the mid-menu, select Tools then ‘Autocite’ from the dropdown. 
3. A popup dialog will display to select the autocite options you wish to run. Select Add TA Patterns to run the standard Tax citations. Additionally, you can select any specific options desired.
4. Click ‘OK’
[image: A screenshot of a computer
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[bookmark: _Toc181625782]Section Autocite
The Section AutoCite tool searches within an open file for either the word “section” or the section symbol, followed by numerals and, after prompting the editor, inserts the proper tagging.
Section AutoCite first asks the editor for the type of citation and the number to be included in the ref attribute. The tool stops at each occurrence of the word “section” or the section symbol for confirmation before inserting the suggested citation markup.  The tool must be run at least once for each type of citation (CFR, USC, etc.) needed.
Note: This tool can be run on an entire file or just a highlighted section of a file.
1. From the Oxygen menu bar, choose Tools > Section AutoCite 
2. Choose the appropriate citation markup from the panel that displays and select OK. 

[image: A screenshot of a computer

Description automatically generated]
3. When prompted, specify the first part of the tag’s ref attribute...like the chapter of the CFR.  For example, the 26 in USC\26 or the 42 in CFR\42.
4. Click OK.
 
5. As Section AutoCite locates section references, confirm each tag insertion. Select: 
1. OK to insert the suggested markup.
2. Skip to skip the reference, such as when this isn't the correction citation type or if it is a section inside a <name> tag, which is never hotlinked.
3. Edit to change the attribute value for this “hit” (for example, if the reference refers to a different section of the USC or the CFR.)  Be sure to edit both the hotlink text and the attribute.  In the example below, Section Autocite is trying to tag "Sections 15 through 20" as one section.  Use Edit to move "-20" to the outside of the tag and remove "-20" from the hotlink text and the attribute.
[image: A computer screen shot of a browser window

Description automatically generated]
[bookmark: _Toc181625783]PDF Preview
This tool may be used to generate a PDF of a document.
1. From the mid-menu, select Tools > PDF Preview which will open the tool.
2. Provide the correct service code associated with the document.
3. Select OK.
4. The PDF file will open into another browser tab.
5. Review, print, or save the file from the browser.

[bookmark: _Ref180490446][bookmark: _Toc181625784]Section 4 – Troubleshooting (Errors)
[bookmark: _Toc181625785]Error types
Common BPub Validation Errors and Warnings (screen shot of BV tool):
1. Sgml2epdm Errors:
Non-SGML characters
· {"error":1,"stdout":"","stderr":
· "EPDM.XOM-029 (08) -- Markup Recoverable Error in file:
· /tmp/5fc64d5d7992fdeffe8229c7d3616c2f/upload.gz, near line 27. A character which is declared in the current concrete syntax to be non-SGML must not be used in the document unless entered using a character reference. The character's character number is 194.
· Solution: Submit an Service Desk Jira Issue: https://jira.bna.com/servicedesk/customer/portal/61
Multiple <name> tags in <content.group>
· EPDM.XOM-029 (08) -- Markup Recoverable Error in file /tmp/856e5bb00eb187416212f5d23a911d7d/upload_1.sgml, near line 14. An end tag that has been declared inomissible (\"-\") must not be omitted. The element is \"SEARCH-HEADING\".
· Solution: If the error log has a "SEARCH-HEADING" problem reported, it usually means there is a <content.group> with an extra <name>. It must be found and removed.
· Tip: Use the Find Element (FE) tool in the right-pane by typing in //content.group/name[2] into the "Element" field and pressing "Next" to locate the duplicate <name> element.
 
(Screen shot of FE tool)
 
2. Duplicate EINs
(Screen shot of this BV warning)
Or use this ??
· Error: duplicate ein: 22bad70399fd403c8534fc6e75fff8fe
· Solution: Click the error reported and go to the Attribute tool to remove the duplicated id value for the element.
· Alternate solution: Copy the id value from the warning. Go to the More menu and select "Edit as XML" use the find tool and copy in the id value. Remove all id="{duplicate value}" from the tags that were matched. Go to menu and select "Switch to Author Mode". Continue editing or repeat for each duplicate value reported in the BV log.
 
 
3. Missing tags Example
· content.group missing required element: 'name'
· Solution: Click the warning reported. Go the top of the <content.group> and add in a <name> element and name text.
4. Tables
· colspec values missing
· Error: Error: No COLNAME attribute was specified on the current COLSPE
· Error: Error: No COLNUM attribute was specified on the current COLSPEC
· Solution: Locate the <table> reported. Check the colspec attributes
(Screen shoot of colspec widget). Fill in the missing values.
5. Empty Elements
· Example: Warning: empty element: <para>
· Solution: Click the warning reported. Add data to the empty tag or delete.

6. URL Check
· Check <cite.url> URL values to see if they resolve to a working website.
· Examples:
· Warning for URL: https://www.impuestos.gob.bo/ckeditor/plugins/imageuploader/uploads/491335f008.pdf curl: (60) SSL certificate problem: unable to get local issuer certificate More details here: https://curl.se/docs/sslcerts.html curl failed to verify the legitimacy of the server and therefore could not establish a secure connection to it. To learn more about this situation and how to fix it, please visit the webpage mentioned above.
·  Warning for URL: http://www.fincen.gov/news_room/ curl: (7) Failed to connect to www.fincen.gov port 80 after 14 ms: Could not connect to server

[bookmark: _Toc181625786]Resolving tag validation errors
Save the file before attempting to resolve errors 
1. Validate file in Oxygen Author Mode.
2. Go to the line number specified in the error message using Edit in XML.
3. Copy the paragraph with the error to a blank Word file.
4. Delete the paragraph in the file. 
5. Validate and see if the error disappears to confirm. 
6. If the error disappears, concentrate and check on the tags within the paragraph that was deleted. Remove each tag one at a time (starting with the tag specified on the error message) to see what particular tag caused the error. 
7. (For new edits) Look at the original Word file to see what new tags were introduced. 
8. Paste the deleted paragraph back to the file and remove the new tags one at a time to determine which one is responsible for the error. 
9. Check the new tags correctness by searching for previous the occurrence in the file. 










[bookmark: _Toc181625787]Section 5 – FAQ's
https://confluence.bna.com/bpdoc/bwip-documentation/faq-for-bwip 
1. Where do I find a document’s BDMS ID? 
a. In BWIP, select a document and expand the right rail navigation via the << icon at the bottom of the screen. The document’s BDMS ID is displayed at the top of the right rail. 
2. What is the BDMS ID used for?
a. The BDMS ID is needed when submitting a Service Desk Jira ticket for help with errors or an issue with a document. 
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